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MpwTOG Pag oTOXOC €ival va avTiypAWoule TNV napakdTtw oeAida:

O1 d1adikacgiec nou nepiypagovTal NapakdTw, JNopouv va npaypartonoindouv kal Je
O1aQOPETIKN OIpd, NePypAPETAl TNV anAouaTePN. ZTIC NEPIOTOTEPEC And TIC puBUIoEIG
Nou KAVOUNE, NMOoPoUNE va enNEPYPBOUPE ava naoa oTIydr. ZTOUC apXAapiouc NpoTeiveTal
vad dkKoAouBnoouv TnV nNpoTIVOPEVN OEIpd, NPOoC ano@uyn NePITTWV KABUOTEPNOEWY Kal
HaKpo-010pOBWOEWV.



Avoiyoupe To Finale.
EpgavileTal To eilcaywyiko napabupo:

KAk navw de&ia oTto Setup Wizard
(Ma TIg unodAoinec entAoYEC Tou napabupou Oa PIARooUPE apyoTepa)
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Eugaviletal To 1° napabupo diapdppwaonc Tou eyypagou:

ErmAg&youpe (av dev ival AdN enIAeyuEva):
Select an Ensemble = Create an Ensemble
Kal

Select a Document Style = Engraved Style
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>70 id10 Nnapabupo opiloupe Kal To PEYEBOG TNG OgAidag TNG NapTITOUPAC KAl TNG
naptag Tou BioAloU nou Ba @TIGEoupe apyoTepPa:

Score Page Size = A4 (20.9991 x 29.70389)

Part Page Size = A4 (20.9991 x 29.70389)



To napdBupo Twpa gaiveral £T0l:

KAlk oto Next

Eugaviletal To 2° napabupo diapdppwong:
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EmAgyoupe (av dev eival emAeypéva) Keyboards < Piano

KAk oto Add (evaAAakTika: 81inAd kAik oto Piano)
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MpooBeToupe To BioAi eniAéyovTac Strings < Violin [single]
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KAk oto Add (evaAAakTika: dinAo kAik oto Violin [single])

To BIoAI npEnel va ypadTei navw anod To niavo.

Ma va To YETAKIVIOOUHE OTn owoTn B€on, To enmAeyoupe (Strings < Violin [single]
< Violin [single]) kal kGvoupue kAIk 0TO nAvw BeAdaki nou BpiokeTAl OTO APIOTEPO
HMEPOC TOu napabupou.



Twpa Ta opyava €xouv Tn owoTn dIaTaén:

KAlk oto Next

Eugaviletal To 3° napabupo diapdppwong:
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SupnAnpwvoupe (dev eival anapaitnTo) Ta nedia (6oa BEAoupe | xpelaldopaoTe).
XpNoIPonoloUPE AATIVIKOUC XAPAKTHAPEC Yia OAa, ¢’auTn Tn ¢pAacn To Nnpoypaupa
moeavov va unv avayvwpilel akoun Ta eAAnvika. Av pag Eepuyel kanoio Aabog,
HnopoUpe va To dilopOwooupE apyoTepa.
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KAk oto Next. EpgavileTal To 4° napabupo diapoppwonc:

EmAEyoupE:
Select a Time Signature = 2/4

Select a Concert Key Signature = kAIK Hia popa oTo NAvw BeAaki
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ZupnAnpwvoupe Ta nedia Text

kal Tempo (ac noUpe OTI To tempo cival: 4°=64)



KAk oTo Finish
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Ep@aviCeTal n diapoppwpevn oeAida. Ta textblocks pnopei va unv €ival otn 8€on Toug,
Ba Ta TaXTONoINOOUKE apyoTeEPA, OTNV TEAIKN Hopgonoinon TnG oeAidac. AAN\waoTe, av
BEAouUpE N ogAida va eival navopoloTunn YE TN OOOMEVN, NPENElI vad NPOOOECOUNE
MEPIKA Kal va apaipeooue kanoia aAAa. ApyoTepa...

EmAgyoupe Save (0nwg kal KaBe popd Nou OAOKANPWVOUHE KATI). AC NOUNE OTI
ovopaloupe To apxeio «sonate». Ekei nou 6a To cwWOOUNE Npenel va egpavileTal wg
sonate.mus
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MnopouUpe va kabopiocoupe Nnwg Ba ¢paiveral To nepIBAAAov epyaciac kabwc Oa

OOUAEUOUE:

View - Scroll View
n

View - Page View
n

View - Studio View

Anod To View pnopouUpe eniong va kavouphe Zoom in [ Zoom out
(evaAAakTika e Ta nAnkTpa [Ctrl]+[+] kai [Ctrl]+[-] avTioToIXQ).

>uveyiCoupe oe Scroll View:

Ma va €ival capeoTeEPEG Ol NAPOUTEC ONUEIWOEIC EXOUV ArMoPakpuvBOei ooa
deuTepevovTa napadbupa dev xpeialopaoTe aueoa. EmAgyoupe Window kai aprivoupe
eNIAEyPEVA JOVO To Main Tool Palette (kevTpikoG nikavakag epyaAsiowv) To Status Bar
(epavilel oTo KATW PEPOC TNG 006VNC TO dvoua Tou pyaA&giou nou €ival Kabe gpopa
EMIAEYHEVO KAl PEPIKEG MANPOPOPIEC YIa TO OE Ti XPNOIKEVUEI) KAl TO OVOUa TOU apxeiou
nou ene&epyalopaocTe (0w TO EXOUME MEl «sonate»).
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Twpa PrnopoUNE va apxXiooupe va YpApOUUE VOTEC.

MnopoUNE va €I0AYOUHE TIC VOTEC JE TPEIC TPOMOUG: a) KE TO NovTiki, B) anod 1o
NANKTPOAOYIO, Y) HE OUVOUAONO Tou NMANKTpoAoyiou kal evocg midi keyboard.
OewpnTIKA HNOPOUKHE Kal va Ypawoupe o< real time aAAa Ta anoTeAeéopaTa sivai
anoyonTeUTIKA.... MnopoUue eniong va ouvOUAOOUNE TOUC Napandavw TpOnouc.

©a avTiypdWOUME TO NMPWTO HETPO Tou BIoAIOU Kal Tou JeEloU XepIoU Ye dUO TPOMOUG:

a) ME TO NOVTIKI

Fia va ypawoupue VOTEG: enMIAEyoUle TNV a&ia, Tnv aAAoiwaon, Tn OTiEN KAM, Kai
KAVOUME KAIK OTO OnMEio Nou BENOUNE va ypaPTEi.

MNa va ypawoupe anAEg ouvnXNOEeIG (OAEG 01 VOTEG ME €va HNACTOUVAKI):
ypApoupEe yia ano TiIc voTeg TNG (BA. napandvw) Kal GUUNANPWVOUNE TIC UNMOAOINEG
KAvovTac KAIK Navw N KATw an’ auTryv, oTd onUeia nou NPeEnel va YeavioTouy.

=ZeKIVAUE PE TO PMEPOC TOU BIoAIoU.

Anod To Main Tool Palette
EMNIAEYOUME TO KOUWUNI

Simple Entry Tool

(oTnv €IkOVa TO TETAPTO APIOTEPA).

To Simple Entry Tool sp@avileTal w¢ auTovoun NaAETa.
Av BEAOUNE, TO TPABANE PE TO MOVTIKI KAl TO
METATPENOUNE O deUTEPEUOV Napabupo, YNopeic va
aAAa&oupe kal To oxnua Tou, onwc BoAeuel Tov Kabeva.
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>710 Simple Entry Tool sniAéyoupe Tnv aia
TNG vOTAc nou BEAoUPE va ypawoupe (ag
noupe OTI Ba YPAWOUNE NMPpwWTA TO I KAl HETA
To Pg), €dw Hi100.

Me To nNovTikli 0dnyoUue To BEAAKI OTO NEVTAYPANUMO EKEI Mou BEAOUUE va ypadTei N
vOTa He a&ia pioou, €dw oTo I (To MIoO-2I (paiveTal pol  axvo oav okia).

Kavoupe kAik Kal n vOoTa €ival €Toiun.
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Ma va ypawoupe Kal To Mi nou ouvnxei Je To 21, Xwpic va aAAa&oupe Tinota and 6oa
EXEIC NON €MAEEEI, Nnyaivoupe To BeAAkl oTn B€on nou BEAOUPE va ypa®Tei, edw oTNV
1" ypapun Tou S5ypdppou Kar akpiBwe Katw ano 1o 21 (To Mi axvopaiverat).

Kavoupe kAIK kal To MiI ep@avileTal kavovika otn 8€on Tou.

JEIpA £XElI TO APIOTEPO XEPI OTO MIAVO.

>10 Siple Entry Palette cniAcyoupe:

a&ia 16°Y kai arolakaroupa (oTnv gikdva:
4° koupni Og€1a kal TeAeuTaio de&ia
avTioToixa)
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Kavoupe kAik oto ®a kal JeTa oto Aa. Mnopei va yn gaivovTal otn cwoTn B€on, Oa
d10pOwBouV auTtopaTa (apyoTepa B6a doupe Nwc d10pOWVOUNE XEIpoKivnTa).

>1n ouvexela oto Siple Entry Palette
EMIAEYOULE:

a&ia 4°Y kal ouleuEn diapkeiag (oTnv
gikova: 3° koupni de€1G KAl NPOTEAEUTAIO
de&la avTigToixa).
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KAIK 0TO Z0A.

EmAg&youpe 16° kal anoemA&youpe (EekAIKAPOUNE;...) TN
ouleuén.
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KAIK 0TO 16° Z0A

KAk otnv a&ia 32° kal otn dieon (5° koupni de&ia kar 7° de&ia
avTioToixa).
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KAk oTo NTo digon

AnosnAéyoupe Tn dieon Kai, HE KAIKApIOUEVo To 32°,



ypAagpoupe 1o Pe

KAk oTnVv avaipeon Kai,
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HE navTta eniAeypevo 1o 32° ypagoupe 1o NTo avaipeon

ANoEnIAEYOUNE TNV avaipeon
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Kal ypagoupe Ta unoioina 32°% (Z1-Aa-=oA)

O1 vOTEG TOU 1°Y pETpou Tou BioAIoU kal Tou apioTepoU XepioU sival ETOINEG (ONH.: N
oUleu&n Npoowdiac ypagpeTal diapopeTika anod Tn oUleu€n diapkeiac, BA. NapakdaTw)

Ma va oBfooUlE VOTEC I VA PMETATPEWYOUHE VOTEG O NAUCEIC ENIAEYEIC TN YOUOAQOTIXa
(1° koupni d€€1a) kal kKAIkapeig Tn voTa.
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B) HE TO NNKTPOAOYIO
MPEMEI NA EINAI MONIMA NMATHMENO TO MNAHKTPO [Caps Lock] KAI NA EINAI

Kdanola ypaupaTta Tou NANKTPoAoyiou avTioToiXoUv O€ ToVIKa uyn:
XaunAn oktaBa: [Z]-NTo, [X]-Pg, [C]-MiI, [V]-®a, [B]-Z0A, [N]-Aq, [M]-ZI
Meoaia oktapa: [A]-NT1o, [S]-Pg, [D]-Mi, [F]-®a, [G]-Z0A, [H]-Aaq, [I]-Z
WnAn oktdBa: [Q]-NTo, [W]-Pg, [E]-Mi, [R]-®a, [T]-Z0A, [Y]-Aa, [U]-ZI

To nANkTpo [I] HETAPEPEI TNV AVTIOTOIXION HIAQ OKTABa XaunAwTepa ano Tnv apxikn
To nANKTPO [, (KOHHa)] PETAPEPEI TNV AVTIOTOIXION WA oOKTABa wnAdTeEpa ano Tnv
apxIkn.

To nANkTpo[K] enava@Epel oTo NANKTPOAOYIO TNV ApXIKN avTioToixion (@’ 0oov EXEl
NPONYOUMEVWC YiVEl HETAPOPA NAVW N KATW).

Kanolol apiOpoi Tou nAnKTpoAoyiou avTigToixouv oTIC a&iec:
[1]-128°,[2]-64°,[3]-16° [4]-8° [5]-4°, [6]-H100, [7]-0AOKANpPO, [8]-OINAOG OAOKANPO

'OAec ol a&iec (Mou €XOUME EVOEXOMEVWC MANKTPOAOYNOEI) YiVOVTAl NAPECTIYHEVEC
natwvTac (ME ToV KEPOOPA Navw TOUC N HETA an’ auTéG) To NANKTpo [. (TeAeia)].

To nANKTPo [+] o€Uvel pia ypauuevn vOTA KATA £va nNUITovio (O0EC (POPEC TO
NAaTroouUpE TOOA NUITOVIa oEUveTal).

To NnANKTPo [-] Bapuvel pia ypaupevn voTa KAaTa €va NUITOVIO NUITOVIO (O0EC POPEC TO
NaTnooupe TOOA NUITOVIA BapuveTat).

To nAnkTpo [Enter] npooBeTel vOTEC O€ YiIa ouvnxnon.

To nARkTpo [=] avTioToiXel oTn oUleu&n Npoowdiac

(@)

T
T

nANkTpo [*] kpUBel N pavepwvel TNV aAAoiwon piag voTag.
nANkTPo [9] aAAalel Tig vOTEG evapuovia.

o O

T
T

nANkTpo [/] opadonoiei yeiTovika 8%, 16% kAn, kal To avTiBeTo.
nANkTpo [L] aAAdalel Tn gopd Tou pnacTouvioU Wiag voTag f piag opadac ano VOTEC.

o O

To NANKTPO [; (EAANVIKO EPpWTNHATIKO — ayyAIKO semicolon) peTaTpenel Ye
d1adoxIka naTAuaTa pia voTa o€ yikpn anotdiatoupa kai diaypaupevn atoliakartoupda.
Me TO TPiTO NATNHA TOU NMAAKTPOU N vOTa &avanaipvel To apxiko TnG YEyeBOC.

MNepioodTepa schortcuts €dw:
http://www.finalemusic.com/UserManuals/Finale2012Win/Content/Finale/Keyboard Shortcuts
and Special Mouse Clicks.htm#HT Speedy Entry Tool



http://www.finalemusic.com/UserManuals/Finale2012Win/Content/Finale/Keyboard_Shortcuts_and_Special_Mouse_Clicks.htm#HT_Speedy_Entry_Tool
http://www.finalemusic.com/UserManuals/Finale2012Win/Content/Finale/Keyboard_Shortcuts_and_Special_Mouse_Clicks.htm#HT_Speedy_Entry_Tool
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MNape va ypawoupe Twpa (av kanoiog €€0ikIwOEei ye To NANKTPOAOYIO, MOAU oUvTopua d€
XpelaleTal va KoITAgl ToOUG Nivakeg avTioToixiong)!

>710 Main Tool Palette cniAéyeic To Speedy
Entry Tool (oTnv sikova: 4° koupni 6g&1a)

KAIK 0TO HETPO Nou BEAOUHE va YpAWOUNE, 3w OTO NPWTO PETPO Tou BIoAIou.
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EugavileTal evac kEpoopac (n KABETN ypAUUr HECA 0TO KOUTAKI MOU MEPIBAAEl TO
METPO, UE PIa MIKPN €vTovn opIlOVTIA YPAUKn). Me Ta NANKTPa-BeAAKIA | HE TO MOVTIKI
METAKIVOUUE TOV KEpoopa op1{OVTIA Kal KAbeTa.

MaTtape To nANKTPo [J] yvia va ndel o kEpoopag oTn 6€on Tou 21 (MNOPoUNE va Tov
0dNYNOOUWE Kal JE Ta NANKTPa-ReAdkia).
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MANkTpoAoyoUpe TNV a&ia, edw [6] (a&ia pioou).

To 21 ival otn B€on Tou. OdnyoUHE ToV KEpoopa, WE Ta BeAdkia () HYE TO MOVTIKI) OTN
B€on nou npenel va npooTeBei To Mi.
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MANkTpoAoyoUue Eava To [6]

H ouvnxnon Mi-ZI gival €Toiun. Me Tov idlo TPONO PNOPOUKE va YPAWOUUE OAEC TIG
anA&g ouvnxnoeig (OAEC ol VOTEC PE €va PMACTOUVAKI).

KAk oTo 1° péTpo Tou apioTepou Xepiou. EvepyonolsiTal To NETPO YIA VA UNOPECOUME
va YpAWOoUNE YETA TOU.
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[F] yia va nasl o kEpoopag otn 8€on Tou ®a kai [2] yia va ypapTei To ®a-32°

[;1 Wia gopad yia va yivel To ®a pikpr anoTtdiaToupa
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[H] ka1 peta [2] yvia va ypapTei To AA-32°
[;]1 yia va yivel To Aa pikpn anotdiatoupa
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Av o1 dU0 HIKpEC vOTEC dev £xouv opadonoinbsi autTopaTa, odnyoUHE TOV KEpoOPA HETA
To Aa (ekei nou Aoyikd 6a BpiokeTal HETA TNV NANKTPOAOYNon Tou Aad) Kal
nAnkTpoAoyoUpe [/]

Av ol vOTeG Og paivovTal owoTd, Yuxpaipia, 8a diopbwbOouv autdépaTta f 6a Tig
O10pOWOOUNE NAPAKATW.

[G] yia To Tovikd Uyoc kal Yetd [5] yia Tnv a&ia, yia va ypdwoupe Tn voTa ZoA-4°
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[=] yia Tn ouleu&n diapkeiag (agaipeitTal Ye To i3I0 NARKTPO)

[3] yia Tnv a&ia (To Tovikd Uwoc npolndapxel) yia To ZoA-16°

[,]1 yia va aveBdooupe To NANKTPOAOYIO Pia 8Ba kail va ypaywoupue To YynAo NTo
(aAAiwC: odnyoUpE ToV KEPpOOPA HE Ta BeAdkia)
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[Q] yia To Tovikd Uyocg (kavovika avTioToixei oto NTo Tou 3°Y diaoTAUaTog, aAAd €@’
000V £XEIC NPONYOUNEVWC naTtnoel To [,], o kKEpoopag Ba ndesl oto NTo nou BEAoUpE)Kal
peta [2] yia Tnv a&ia yia va ypayeig 1o NTo-32°,

kal otn ouvéxela [+] yia va ofuvoupe To NT0-32° o NTo#-32°

[W] via To Tovikd Uwog kai [2] yia Tnv a&ia yia To Pe-32%
[Q] kai [2] To NTo (n avaipeon ypa®Tnke autouaTa).

[K] yia enavagopd Tou nAnkTpoAoyiou (avaipeon TnG YETAPOPAC NOU EIXE YiVEI HE TO
narnua Tou [,]).
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[U] ka1 [2] yia To 21-32°
[Y] kai [2] yia To Aa-32°
[T] ka1 [2] yia TOo Z0A-32°

KAIk €€Ew ano 1o PeTpo (1 naTtac To nARKTpo [0]) yia va doUpe To PHETPO. AoyiKa Ol
VOTEC BpiokovTal TN OwOoTH TOuG BEon.

A@OU TEAEIWOOUME HE TIC VOTEC (aveEapTnTa noia JEBodo XpnOoIKonoinoape yia va TIG
YPAWOUNE), HrnopoUpe va BAAoupe TIG dUo ouleU&eic Nnpoowdiac (Yevika NPOTEIVETAI Ol
ouleU&eic va ynaivouv PeTa and Ta oUBoAa apbpwonc, edw Opwc dev TiBeTal Bepa).



-37-

>70 Main Tool Palette cniAfyoupe 1o Slur Tool (oTnv sikova: 6° koupni de€id) kai
eppaviCetal To Smart Shape Tool (oTnVv sikova: To 0ei deuTepelov Napabupo HE Ta
MMAE KoupMna).

>71o Smart Shape Tool sniAéyoupe To Koupni e TN Asykatoupa (otnv sikova: 1°
koupni 0g&a — oTnv 0€€ld naAgra...).

AINAO KAIK 0TO HIKPO ®a KAl KPATAPE NATNHEVO TO NMANKTPO TOU MOVTIKIOU, TO WIKpO da
NPEnNel va oKIAOTEI..

Me natnuévo (anod npiv) To NANKTPO TOU, OEPVOUHE TO MOVTIKI HEXPI VA OKIAOTEI n vOoTa
oTnv 8a kataAAn&sl n AeykaTtoupa, £dw To Z0oA-4°
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APRAVOUNE TO NANKTPO TOU MOVTIKIOU. H AeykaToUpa npenel va €ival otn ocwoTn 0€on.
O1 JIkpoi pOuBoI 0Ta AKpa KAl TO HECO TOU MEPIYPAPMATOC TNG AsykaToupag
XPNOIMEUOUV YIa va TPOMOMOINCOUMNE TO NNKOC KAl TNV KAPMNUAOTNTA TNG.

AINAO KAIk oTo NTO#-32° uéXpl va OKIQOTEl Kal JE NATNHUEVO TO NANKTPO ToU,

O£PVOUWE TO MOVTIKI JEXPI VA OKIAOTEl KAl TO Z0A-32°
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AaPrVOUNE TO MOVTIKI.

H Aeykatoupa npenel, Aoyikd, va BpioKeTal oTn owoTn B€on
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AZKHzH 1:

EEaoknOeiTe 0 000000Ad Ta Napanavw, avriypa@ovrag ano Tn Soouévn
g€Aida 0Ao To HEPOG TOU BIOAIOU.

KAAH AIAZKEAAZH...!
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>TO NPWTO PETPO-OeEi XEPI BEAOUNE va Xwpiooupe Ta €€ 32° o dUO opadeg (Hia Twyv 2
Kal hia Twv 4). MNp€nsl va «onacoupe» Tn ypauun Tou 32°%° aAAd ol unoAoineg (Twv
16“Y) va peivouv oTn B€on TOUC.

Edw 6a xpeiacTtoupe Ta Advanced Tools
EmAgyoupe To Special Tools

EpgaviCetal n Special Tools Palette,
oTnVv onoia eniAéyoupe To kouuni Beam Brake Tool:
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Kavoupe KAIK 0TO PJETPO Nou BEAOUNE Kal egpavidovTal TETpAywvdakia navw ano TIG
VOTEC NOU PNOPOUKE va ENEPPOUPE

Kavoupe dINnAO KAIK OTO TETPAYWVAKI TNG VOTAC an’ Tnv onoia &EkIvasl To Xwpioua
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eppaviletal To Secondary Beam Break Selection

oTo onoio enmAéyoups To 32° (Tnv aia nou BEAOUHE va XWPICOUWE)

MNaTtaue OK. 'ETolpo!
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a)Me 1o novrTikI:
EmAgyoupe To Simple Entry Tool:

>TNV NaAETTa PE TIC a&iec emAéyoupe Tnv afia pacg (16°) kal To €1kovidio PeE To 3nXO:

MANKTPOAOYOUHE WE TO NOVTIKI TIC VOTEC
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B) M& To NANKTPOAOYIO:
EmAgyoupe To Speedy Entry Tool

Mnaivoupe oTo YETPO NMou BEAOUME va YPAWOULE.
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MNatape padi [Option]+[povada 3nxou], v npokeiyevw [Option]+[3]. Navw de€ia
OTO TETPAYWVO Nou NePPBAAElI TO YHETPO gu@avileTal Eva Pikpo 3. AUTO onuaivel oTi ol
VOTEC Nou Ba nAnkTpoAoynooupe Ba eival 3nxa (av eixaue natnoel [control]+[6] Ba

ey@avifoTav eva 6 kal 6a ypa@ape 6nxa Kok).

H npwTn a&ia nou 8a nANKTPOAOYNOOUWE €ival n Jovada Tou 3nxou. Edw nAnKkTpoAoyw
[3] (16°) kal ypapw TIC VOTEC HOU
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Ta 3apia Twv dU0 NPpWTWV 3NXWV MPENEl va NAve NAvw ano TIC VOTEC. TwV unoAoinwyv
npenelr va eEagavioTouyv.

EniAéyoupe To Tupplet Tool
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Kavoupe KAIK oTnV NpwTn VOTA TOU 3nNX0U KI eupavileTal £va TETPAywVakli

Me To NovTikl oEpvw Ta 3apia oTn B€on nou BEAw va gpgavilovral.
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EmAg&yw To TpiTo 3nX0 (Nou BeAw va kpUWw To 3apl Tou),

Kavw JINAO KAIK OTO TETPAYWVAKI TOU KI EJpavileTal To napabupo eneEepyaaiac Tou
3nxou
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Kavw TIC anapaitnTeg emAoyeC kal nataw OK
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EnavaAauBavw Tnv idia diadikacia oTo TETAPTO 3NXO

‘ETOIMO!



-53-
>naw Ta 3nxa ava 3 (Je Tn pEBodo nou neplypdPnke napanavw)

And To napabupo eneEepyaoiac Tou 3nNXouU, JE AvaAoyeC ENIAOYEC, UNOopw va dwow OTa
Tupplets diapopec pHOpPEC:
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>Tn ouvéxela Ba BaAoupe To onueio TNG enavaAnync:
EmAgyoupe To Repeat Tool

Kavoupe dINAO KAIK OTO HJETPO NMou BEAOUHE
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KI aVOiYEl TO NAPAKATW:

EMNIAEYOUNE TNV enavainyn rnou B€Aoupe kal nataue Select.

Avoiyel To napakaTtw napdadupo. Matdape OK
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H enavaAnuyn ival €Toiun

>Tn OUVEXEId KAVOUUE OINAO KAIK OTO ENOPEVO PETPO
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Kal oTo Napabupo nou avoiyel, ENIAEYOUHE TNV KaTAAANAN enavainyn

MNataue Select
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Me Ta YEXPI TWPA €iHacTE 0 B€0N va YpAWOUNE OAEC TIC VOTEC TNG OgAidac. Meavov
oTnv 0080vn pag va @aiveral Aiyo avw Katw ny

Mpiv NPpOOOECOUNE Ta oNHEIa apOpwonG, EKPopPac, SUVAHIKEG, AEYKATOUPEG
KAN. KaAo €ival va HopPONOINOOUHE TN OcAida HaG, WOTE va Ta TONOOETOUHE
Kal va Ta BAENOUHE oTnv 000vn Onwg 6a paivovTal Kal oTNV EKTUNWON.

2TO ENMOMENO MAGHMA...
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NMape va HopPONOINCOUHE TN OeAida pag
Znu.: EVVOEITAl Nw¢ Ol EVEPYEIC Nou akoAouBouv Oev €ival UNOXPEWTIKO va yivouv LIE
TN O€Ipd nou nepiypd@ovrai. Enionc or Tiuec nou Ba divouue ora napdbupa rou
akoAouBouv eival evOEIKTIKEC, KABe popd rnpenel va 0oKIUAlOUUE yia va NMETUXOULE TO
KAAUTEPO Kal KOUWOTEPO dUVATO ANOTEAEOUA
MpwTa 8a opIKPUVOUHE Aiyo TIG vOTEG. Mia pEon TIMA avayvwong yia Ta gepn €ivar 85-
90% TwV opyavwy, yia TIC NapTITOUpPEC eEapTdTal ano To TI nepieExouv (nooa opyava,
nOCO MUKV €ival N JOUGCIKN KAM.)

EnmiAéyoups: Main Tool Palette > Resize Tool

>Tn Resize Page nou avoiyel cupnAnpwvoupe Resize Page To: 85%, Page 1
Through the End of Piece (evdexopevwc: All Pages), Hold Margins, Update
Pege Format.



MNataue OK
H oeAida pac deixvel Kanwg €101
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Twpa 6a opikpUVOURE TO S5ypappo Tou BioAiou.

Me eniAeypevo navta 1o Resize Tool, kavoupe kAIk ndvw oTo 5ypappo atou BioAliou.
>710 Resize Staff nou avoiyel, cunpAnpwvoupe Resize Staff To: 65%, System 1
Through The End of Piece.

MNatape OK. H ogAida deixvel KAnwc £T0l:



-62-
>Tn ouvéxela Ba d10pOWOOUNE TIC ANOOTACEIC avaueoa oTa 5ypapua.
>Tn Main Tool Palette sniAéyoupe 1o Staff Tool



-63-
KavovTac kAik dinAa oto 5ypappo Tou de€lou XepIoU To eNIAEyYoUNE (MPOOoOXN Vva
eMIAeyel OAOKANPO) ME TO MOVTIKI OEPVOUNE TO TETPAYWVAKI TOU NPOC TA NAV®
MEXPI Va nael oTn B€on nou BEAouUPE (va gnv HNAEKOVTAI Ol VOTEC TWV SYPAPP®V).
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Kavoupe T0 idl0 Kal 0To 5ypaupo Tou apioTepou Xepiou.

Twpa O6a YETAKIVI)OOUHE Ta PETPA Nou dev BpiokovTal 0To owoTO cuoTnua (kaTtda To
npoTund pac).
Main Tool Palette>Selection Tool



-65-
EmA&youpe kKGBe popd To PHETPO NMou BEAOUME VA PETAKIVIIOOUHPE OTO MPONYOUHEVO N
OTO ENOHPEVO oUOTNHA, KAl TO YHETAKIVOUME NATWVTAG TO NAVW N TO KATW BEAAKI ToU
nNANKTpoAoyiou pag:



-66-



-67-
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Twpa 6a popponoinooupe Tn oeAida pac.
Main Tool Palette->Page Layout Tool

Page Layout->Page Size



-69-
>To Napabupo rnou avoiyel EMAEYOUUE
A4, Portrait, All Pages

OK

KaAo €ival va opiow w¢ povada PETPNONG To EKATOOTO (OUVABWC €ival NMPOEMIAEYHEVN
n ivroa).
Edit>Mesurement Units>Centimeters



-70-
OpiCoupe Ta nepibwpia. Me eniAeyuevo navra to Page Layout Tool
Page Layout->Page Margins->Edit Page Margins

Avoiyel To napabupo Edit Page Margins.EniAcyoupe All Pages kal cUNNANpWVOUUE
Topl.27-Leftl.27Rightl1.27-Bottom 1.27



-71-
OpiCoupe TIC anooTaoelC avauyeoa oTa ouoThUaTa 5ypaupwy. Opifoupe Ta nepibwpia.
Me eniAeypevo navrta To Page Layout Tool
Page Layout->Systems—>Edit Margins

>T0o napabupo nou avoiyel emAgyoupe All, TopO-Left0-Right0-BottomO0, Space
Between Systems1.3

nataue Apply
To npwTo oUOTNUA Npenel va KaTeRel Aiyo yia va dwaoel Xwpo OToV TITAO Kal va
Eekivasl ano Aiyo nio Pyéoa yia va ¢paivovTadl Kal Ta ovouaTad TwV opyavwy.
>To napdabupo Edit System Margins nou €xoupe NON avoi&el eNIAEYOUUE
System 1 Thru 1, Top-1.2, Left-2, Right-0, Bottom-0, Distance between
Systems 1.4

nataue Apply
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Ma va YETaKIVow Ta nNAdiola KeIJEvou oTn oVoTr Toug BEon eMIAEYw
Main Tool Palette>Text Tool

Kal JE To NovTikl oepvw €va eva Ta Text Blocks (ano 1o TeTpaywvaki Toug) otn 6€on
nou BéAw
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>Tnv napTitoupa rnou avTiypa@oupe Osv (paivovTal apiBuoi HETPWV.
Ma va Toug Kpuyw

Main Tool Palette->Mesure Tool

oTn ouvexeia Mesure->Edit Mesure Number Regions



-74-
Mapdabupo nou avoiyel emAeyw Region->Delete> 0K



O1 apiBuoi TWV HETPWV EQuUYAV

-75-
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MNa va ypaww Ta onuadia apbpwaong
Main Tool Palette~>Ariculation Tool

KAIK navw oTn voTa nou BéAw va ypdyw To onuadi.
Avoiyel To Articulation Selection,cniAéyw To onuadl nou BEAW

MaTtaw Select

To onuad ival otn B€on Tou.Ano To TETPAYWVAKI TOU PMNOPW VA TO HETAKIVAOW av
XPEIAOTEI.



-77-
MNa va ypaww Ta onueia Ekppaonc
Main Tool Palette>Expression Tool

Ma va diopbwow (N kal va dnuioupynow) &va onuadi
AINAOG KAIK OTO TETPAYWVAKI TOU



-78-
Avoiyel To napabupo Expression Tool

Mataw Edit



-79-
Avoiyel To Expression Designer

Alopbwvw

naTaw
OK



EmoTpe@w oTo nponyoupevo

MNataw Assign

AlopBwOnke

-80-



MNa va ypaww &va onuadi
AINAOG kKAIK NnAvw OTn vOTA Nou BEAW

EmAgyw

Assign

TonoBeTnOnkKe

-81-
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>Tn ouvéxela Baldw AeykaToUpec Pe TN PEBODO nou €xel NON NeEPIYPAPEI.
3TNV ouoia av OAOKANPWOW TIC MPONYOUHEVEC EVEPYEIEC EXW TEAEIWOEI UE TNV

avTiypagn Tng ogAidag pou.

AcC unoBeooupe OTI BEAW va avTiypayww TNV Nnapakdatw oeAida



Ta pova kaivoupla oToixXEia ivai:

Na gn aiveral To HETPO
Main Tool Palette->Mesure Tool

-83-



EMNIAEYW TO PETPO BEAW

>To napabupo rnou avoiyel

-84-



EniAéyw Time Signature->Always Hide

nataw OK
ETOIHO

-85-
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AAAayn onAiIGHOU OTN HECTH TOU KOHHATIOU

Main Tool Palette>Key Signature Tool

EMmAEYw TO PHETPO Mou BEAW
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AInAO6 kAIK NAvw Tou Kal 0TO NAapadbupo rnou avoiyel

KAVW TIG PUBNICEIC NoU BEAW

Mataw OK



-88-

Balw kar TIG enavaAnyeic Je Tn YEB0DO nou €xel NON NePIypaAPEi
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AAAayn kA€1010U 0T HECTH TOU KOHMHATIOU
Main Tool Palette>Clef Tool

AINAO KAIK O0TO PETPO NOU BEAW va aAAd&w To KAEIDI



-90-
>To napabupo nou avoiyel Kavw TIC EMAOYEC HOU

MNatdw OK
‘ETOIHO

TQPA EXOYME OAA TA AMNAPAITHTA E®OAIA I'TA NA ANTITPAWOYME
NMAHPQZ TIZ AYO ZEAIAEZ NOY EXOYN MEXPI ZTITMHZ AOOEI

KAAH AIAZKEAAZH
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A@ouU avTiypayape oAOKANpN Tn oeAida npenel va €EAYOUE TNV NAPTA Tou BIoAlou.
EnmiAéyoupe File>Extract Parts
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avoiyel avaioyo napadupo

av dev gugavifovtal AdN Ta €ni yEpouc O6pyava, nataue Generate Parts kai
EMNIAEYOUME TIC NAPTEC Nou BEAOUNE va eEayoupe, edw Tou BIoAIoU
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natape OK

owl(OUPE TO KAlVoUPIo apxeio Kal dIaHopPWVOUHE TN OgAida pag kaTd Ta yvword.
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Suxva xpelaleral va eEayoupe pia napTitoupa (n YEPOC TNG) o€ €IkOvVa, n.X. yid va
€10AYOUHE PJOUOIKA napadsiyyaTa o€ hia epyaocia, va QTIAEoupe eknaldeuTIKO UAIKO
KA.
Mnopoupe va eEayoupe oAOKANPN oeAida (] OAEG TIG oeAideg TNG NON JIAHOPPWHEVNG
napTiToupag oc EexwpPIoTa apxeia).
EniAéyoupe Tools>Advanced Tools->Graphics

>Tn ouvéxela Graphics>Export Pages



-95-
Avoiyel To avaAoyo napadbupo

Mnopw va €nIAEEW PHopPpr apxeiou, NOOEC aeAidec BEAW va eEayw kal nou va cwbouv.
MNatdw OK kal o unoAoyioTnG YE pWTAEl NOU BEAW va owoel To apxeio nou Oa eEaxOsi.

Mnopw va €Eayw kal anoonacpa napTiTtoupac. Me eniAeyuevo To Graphics Tool



-96-
Kavw 8imAo kAIk ndvw oTnv napTiTtoupa Kal oxnuatidw €va nAaiolo niAéyovTag 1o
andéonaopa nou BEAw va €EAyw o€ €ikova.

eniAéeyw Export Selection

oTn ouvexela owl{w ONwc Kalr Nnapanavw.
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Ac noupe OTI BEAW va avTiypdyw oTto 35° anod Ta 371 xopika Tou J.S.Bach kai n
napTiToUpa pou va Oeixvel Kata To duvaTov idia JE To NpwTOTUNO.

emnAeyw File>New->Document With Setup Wizard



-08-
EMAEYW TIC KATAAANAEC puBpioEIg

Next
eEMNIAEYw Opyava (€kava Tn auTn TNV €nmiAoyn yia va pou BydAel kaTt'euBeiav To ouoTnua
nou xpeialopat)

Next-> Next



EMNIAEYW PETPO, KAIipaka

Finish
EmAgyw
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A€€i KAIK 0TO NAVW OTO TETPAYWVAKI TNG AYKUANG



-101-
Full Group Name > Edit

OK-> 0K
>BAvVw Ta nepiola PETPA



-102-

Alauop@wvw Tn geAida Pou

Apply
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Twpa Pnopw va apxiow va ypaew TIG VOTEC HoU.
H mo anAn pgBodog eival va ypayw Tn conpavo oto layer 1 (katw 0g€1d O0TO KEVTPIKO
napabupo Tou finale)

TNV aAto oto layer 2
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TNV apxn Tou TPITOU PETPOU EXW TPEIC PWVEGC. Oa ypdww TNV TpiTn voTa oTo layer 3

OMOIWG YPAPW Tov TeVOpo oTo layer 1 kal To ynacco oto layer 2

(oTO TPiTO METPO O TEVOPOC EEKIVAEI OTNV TPITN Kivnon —TIG OUO NPWTEG TIC EXW YPAWEI
oTo KeAIOi TOU 0OA- Ba BAAw Nnavuoelc oTa dUO NPWTA TETAPTA Kal Ba TIC KAvw adpaTeg
HE To [O] opiIkpoOV).
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Z€pw NMwc o TITAOC KABe XopikoU ano Ta 371 sival kai n NnpwTn ¢pacn Tou, Apa HUNopw
va BaAw kai Aoyia.
EniAéyw Lyrics Tool



-107-
>1n ouvexela Lyrics>Lyrics Window (os naAioTepeg versions: Lyrics>Edit Lyrics)

>To napabupo rnou avoiyel
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ypdpw Ta Aoyia

Kal Xwpilw TIG CUAANABEC Pe HEOAIEG NAUAEG
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EmAéyw Lyrics>Click Assignment
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KavovTtag KAk KaTtw (A navw) ano TIG KaTAAANAEG VOTEG, TONOBETW TIC GUAAABEG
Av BEAW va ypaww kal deUTePN OTPOPN:
EMIAEYW
Lyrics>Specify Current Lyric
Verse, Number2

Fpa@w Ta kaivouplia Aoyia
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Kal Ta «xTundaw» oTtnv napTitoupa

>€pvovTag Ta avaloya BeAdkia oto Ol pEPOC TNG oeAidac pubuilw TNV anooTaon TG
NpwWTNG YPAMMNG KAl TIC anooTACEIC avAUETA OTOUG OTiXOUG ano TIG VOTEG

KaAn diaokEdaon!!!



-112-
AG noUpe OTI EXOUME va avTlypaWoulue OTNV NApakaTw napTioToupa:
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To KopuaT dev €ival XWPIOPEVO O UETPA, EPEIC OPWG MPEMElI VA TO YPAWOUHE KAVOVIKA
ME YETPA KAl YETA va Ta KpUWOUHE. Oa pnopoucape va opicoupe PETPO 13/4 kal va Ta
YPAWOUME OAa O€ €va PETPO, AAAG O NIo NEPINAOKEC NEPINTWOEIC AUTH N AUon dgv
gival npakTikn. MNa Tnv napouca napTitoupa NPOTEIVW va Tn YPAWOUUE OE YETPA TOU
1/4 kal yeTa va Ta kavoupe aopara.
Opilw Aoinov:
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KAIk oTo kKoupni he Ta dU0 EpwTNUATIKA KAl avoiyel To NnapakaTw
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Opilw TIC CWOTEC TIUEC
Number of Beats: 1, Beat Duration: 4

OK

Finish
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Fpapw TIC VOTEC TOU dEIoU XEPIOU OTO NAVW 5ypappo Kal Tou apioTEPOU OTO KATW

SYpappo

>Tn ouvexela eniAéyw Selection Tool

EmA&yw OAo To ndvw nevraypaguo



-117-
EniAiyw Utilities>Stem Direction>Up

Kail 0Aa Ta oTeAExn oTpEPOVTAl NPOC TA NAVW
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Ae€i KAIK NAvw oTnv NN NIAEYHEVN NEPIOXN Kal ENIAEYW
Barline>Invisimble
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EniAéyw Mesure Tool

>Tn OUVEXEIA KPUBW TO PETPO HE TN YVWOTH anod nponyouueva padnuarta pebodo

Twpa 6a PeETAPEPW KAMOIEC VOTEC TOU KATW 5ypdappou oto navw 5ypappo
>T1a Special Tools sniAéyw Note Mover Tool
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EmAéyw NoteMover->Cross Staff

Kavw kAik 0TO JETPO Tou Kal eNIAEYw To NTO rMou BEAW va HETAPEPW

OTN OUVEXEIQ JE NATNHUEVO TO MOVTIKI OEpVW TO Pe# oTo S5ypaupo nou BEAW va To
HETAPEPW
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Kavw To id10 Kal yia TIC unoAoineg VOTEG NOU NPENEl va JeTapepBouv

>1n ouvexela Advabced Tools = Special Tools = Special Tool Palette->Tie Tool

Kavw kAIk navw oTtnv Aeykatoupa rnou dev QpaiveTdl owoTd
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OEPVOVTAC NAVW-KATW Kal 0e€1a-apioTepd Ta KouTdkia TNG, TN S10pfwvw

EniAéyw Reverse Stem Tool

Kavw KAIK OTO JETPO Nou €xel dlaoTAUPOUHEVEG VOTEC
EMmAEYw To HETPO KAl OTN OUVEXEIA TO KATW O€&i KOUTAKI
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EniAéyw Beam Angle Tool

Kal 0EpvVw TO JEEi KOUTAKI OTN owoTH B€0n

SEPVW TO APIOTEPO KOUTAKI yia va dwow TN owoTn KAion
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EnavaAauBavw Tn diadikacia onou £xw d1A0TAUPOUHPEVEC VOTEG

To 3° ouoTtnua

OEAW va €xel HOVO €va 5ypappo. ©a kpuww To aAlo.
>Tn Main Tool Palette cniAcyw Staff Tool



-125-
EmAEYw TNV nepioxrn nou BeAw va KpUuYw

Kavw de&i kAIk navw Tn¢ kai emAeyw 12a. Force Hide Staff: Cutaway 1
12b. Force Hide Staff: Collapse (| o naAioTepeg version anAa Hide Staff)
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'ETOIMO
Alapoppwvw Tn oeAida Jou KATda Ta YVWOTA, CUPNANPWV®W Ta OTOIXEIA NOuU Aginouv

T€AoG UANG 6unvou.
KaAn enmituyia!l





